
Chapter 1

ACTIVE-State Editor User’s Guide

ACTIVE-CAD System Components
ACTIVE State Editor is a part of the ACTIVE-CAD design environment
which supports device and system-level designs. ACTIVE-CAD includes
the following closely associated software products:

ACTIVE-CAD Project Manager
ACTIVE-CAD Schematic Editor
ACTIVE-CAD Logic Simulator
ACTIVE-CAD Library Manager
ACTIVE-CAD Symbol Editor
ACTIVE-CAD Static Timing Analyzer
ACTIVE-CAD HDL Editor

Additional information on these tools can be found in the following
documents:

ACTIVE-CAD Project Manager User’s Guide
ACTIVE-CAD Schematic Editor User’s Guide
ACTIVE-CAD Logic Simulator User’s Guide
ACTIVE-XILINX XilinxTM Applications



Preface
ACTIVE State Editor allows entering designs in the form of functional
diagrams instead of the traditional cell and device-based schematic dia-
grams. The editor supports finite state machine (FSM) design entry, veri-
fication, and automatically converts design into a selected HDL code.
Using some additional ACTIVE-CAD software products you can simu-
late the FSM diagrams and convert them into netlists for ASIC and FPGA
devices.

From this manual you will learn how to effectively use ACTIVE State
Editor to enter and check design, and how to compile them into HDL
files.

Following topics will be covered:

r system requirements
r installation
r FSM Diagram entry and editing
r compilation of the State Machine into VHDL or ABEL Code

The manual shows some sample VHDL and ABEL designs (Applications
Chapter). It also includes Glossary, Basic Vocabulary and Commonly
Used Abbreviations.
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Introduction

ACTIVE-CAD - State Editor Features Overview
The state machine editors allow you to enter your designs in the form of
functional diagrams. Used quite widely in the 50’s, the state machine edi-
tors came back in the 90’s to simplify the complex designs through
graphical design representation. The state machine designs are best
suited to describe control applications, in which a sequence of events is
taking place without extensive data manipulations.

The basic premise of the new generation of the state machine editors is to
minimise the manual design entry. Only some basic design information
is needed. Everything else is automatically provided by the software, in-
cluding:

r checking whether there are any inconsistencies in the design
r automatic VHDL and ABEL code generation from the FSM graphs
r animation of the graphs for better understanding of information flow

Since today’s technology involves complex relationships between data
and control signals, ACTIVE-State Editor allows you to enter these signal
conditions and relationships in an easy and efficient manner.

This User’s Guide allows you to get a quick grasp of the ACTIVE-State
Editor features. The enclosed Application Guide provides several exam-
ples with increasing complexity which will teach you the basics of using
the state machine editor.

Installation
The ACTIVE-State Editor is automatically installed with the ACTIVE-
CAD 2.0 or higher. However, special option in your keylock (dongle)
must be programmed to activate this software.

Requirements
The ACTIVE-State Editor is an add-on to ACTIVE-CAD and does not
put any additional requirements which are:

r IBM 486/Pentium compatible computer
r Windows 3.1, 95 or NT
r Minimum of 16 Mbytes of RAM
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r 50 Mbytes of free hard disk space
r SVGA graphics board
r 2- or 3-button mouse device

Additional Requirements
r HDL Editor (provided with ACTIVE-CAD 2.0 and higher)·
r VHDL Compiler (provided with ACTIVE-CAD 2.0 and higher)

WINDOWS Environment
The WINDOWS operating system communicates with the user by means
of graphical objects such as windows, icons and buttons. Operations on
these objects are performed with the help of mouse buttons and key-
board keys. In this manual all screenshots were taken from the ACTIVE
State Editor working on Windows ‘95 platform. If you are not familiar
with Windows ‘95, please read The Elements of Windows ‘95 User Inter-
face chapter at the end of this manual.

System Start-Up
ACTIVE-State Editor is usually invoked from the Project Manager or
Schematic.

When the State Editor is started from the Project Manager icon, the wel-
come screen (Figure 1-1) allows selecting one of the existing diagram
files or creating the newone.

Figure 1-1. ACTIVE State Editor Welcome Screen.
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ACTIVE-State Editor Window
ACTIVE-State Editor window is shown in the Figure 1-2 below.

ACTIVE State Editor main window is comprised of the following items:

Window title bar - located at the top of the window. It lists the program
name and the current document name, e.g. State Editor [AUTO-COOL-
ING]. If no document has been selected, the title bar will display the [Un-
titled] message. If several windows are opened simultaneously, the color
of the currently selected window’s title bar will differ from the others.
You can change the window’s position on the screen by dragging the ac-
tive window title bar with the mouse.

Menu bar - located under the title bar. It contains the following main
menu options:

File, Edit, Search, View, FSM, Draw, Synthesis, Project,Tools and Help.

Figure 1-2. ACTIVE State Editor Main Window.
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Main Menu Options
Note: If you click on a main menu option or program option, a pull-down
menu will be displayed, listing the associated ‘hot keys’ in square brack-
ets. Clicking on the underscored letter (keyboard key) will also invoke the
selected operation.

File
r New [CTRL+N] - Creates a new document.
r Open [CTRL+O] - Saves the active document and opens an existing

document.
r Save [CTRL+S] - Saves the active document.
r Save As - Saves the active document with a new name. This option is

not present when the State Editor is invoked by ACTIVE-CAD.
r Print [CTRL+P] - Prints the active document.
r Print Preview - Displays full pages as they will be printed.
r Print Setup - Changes the printer and printing options.
r Page Setup - Changes paper size.
r <Recent File List> - Opens one of four recently edited diagrams.
r Exit - Quits the application; prompts to save documents.

Edit

r Undo [CTRL+Z] - Undoes the last action
r Redo [CTRL+A] - Redoes (cancels) the previously undone action
r Cut [CTRL+X] - Cuts the selected items and puts them on the Clip-

board.
r Copy [CTRL+C] - Copies the selected items and puts them on the

Clipboard
r Paste [CTRL+V] - Inserts the Clipboard’s contents (pastes copied or cut

items).
r Delete [DEL] - Erases the selected items.
r Select All - Selects all items in a field of the entire diagram.
r Symbol - Allows editing the symbol representing the state diagram in

the Schematic Editor.
r Settings - Chooses Text, Line and Fill bundles settings.

Search
r Find String [Alt+F3] - Finds the specified text
r Find Next [F3] - Repeats the last Find String or Find Next
r Replace - Replaces the selected text with the desired text.
r Previous error [Shift+F4] - Shows the previous error found during

generation.
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r Next error [F4] - Shows the next error found during generation.

View

r Zoom in [CTRL +] - Zooms the diagram to 200%
r Zoom out [CTRL -] - Zooms the diagram to 50%
r Zoom Select - Selects zoom rectangle for continuous Zoom.
r Page [PgDn] - Shows the whole page
r Previous [PgUp] - Shows the previously visible part of the diagram.
r Toolbars - Displays sub-menu for selecting visible toolbars.
r Status bar - Shows or hides the status bar.
r Machine Frames - Shows or hides frames of machines.
r Grid - Sets grid options.
r Redraw [F10] - Redraws the entire window.

FSM

r Machines - Displays a sub-menu for selecting the current machine in
a diagram comprised of multiple machines.

r Select - Selects and edits; allows such editing operations as drag, delete,
etc.

r State - Adds states to machines; it is used for entering the machine states
or ‘bubbles’

r Transition - Adds transition to machines; it is used for drawing state
transition lines.

r Condition - Adds/Edits condition of a transition; allows to specify the
conditions that cause a transition to a new state.

r Action - Displays sub-menu for selecting actions taken by the machine
r Declarations - Adds/Edits declarations to machine or diagram.
r Input Port - Adds/Edits input port to the diagram; used for drawing

input ports.
r Output Port - Adds/Edits output port to the diagram; used for draw-

ing output ports.

Draw

r Text - Allows drawing text on the diagram.
r Bezier Curve - Allows drawing Bezier curves on the diagram.
r Circle - Allows drawing circles on the diagram.
r Rectangle - Allows drawing rectangles on the diagram.

Synthesis

r Configuration - Customizes synthesis options.
r HDL Code Generation [CTRL+H] - Generates HDL Code
r Options ... - Customizes synthesis tools options.
r Synthesize - Starts synthesis tool.
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r View Report - Displays a report listing the compilation flow and er-
rors.

Tools

r Preferences - Customizes configuration
r Project Manager - Activates Project Manager
r HDL Editor - Runs HDL Editor
r Simulation - Starts simulation

Help

r Help Topics - Lists Help topics.
r Using Help - Displays instructions on how to use Help.
r About State Editor - Displays the program information, its version

number and the copyright notice.

Detailed Menu Description

The File Menu Options

File | New [CTRL+N]

Allows to create a new document. Selecting this option displays the De-
sign Wizard Welcome Window (Figure 1-4).

Figure 1-3. File Pull-Down Menu.
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Clicking on the Next button in the wizard’s welcome window displays
HDL Language Selection window (Figure 1-5).

You need to select in that window the language into which the FSM dia-
gram will be converted. Currently only ABEL and VHDL languages are
supported. Please remember that the FSM diagram does not have any
electrical meaning without an HDL representation.

1. Clicking on the Back button displays the preceding window.

Figure 1-4. FSM Design Wizard Welcome Window.

Figure 1-5. Design Wizard - Language Selection
Window.
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2. Clicking on the Next button, activates the next window, which in this
case it is the Design Wizard - Name window (Figure 1-6).

3. The Cancel button cancels the design entry and stops Design Wizard.

The name of the diagram can be entered in the Design Wizard - Name
window.

1. Clicking on the Back button displays the preceding window.

2. Clicking on the Next button, activates the next window, which in this
case it is the Design Wizard - Ports window (Figure 1-7).

3. The Cancel button cancels the design entry and stops FSM Wizard.

Figure 1-6. Design Wizard - Name Window.

Figure 1-7. Design Wizard - Ports Window
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In the Design Wizard - Ports window you should enter the port’s name,
range (for bus ports only) and type. After entering this information, you
should press the Add button. If a mistake has been made, select the port
from the list and press either the Delete button or make changes to the
port and press the Change button to reenter port information. The Back,
Next and Cancel buttons have the same meaning as in the previous win-
dow.

Clicking Next displays the Design Wizard - Machines window (Figure 1-
8).

The Machines window allows you to select how many state machines the
FSM diagram will have. Clicking on the Page Setup button displays the
window where diagram sheet size and orientation can be changed. Click-
ing on the Finish button, completes the design and State Editor exits the
Wizard. Back and Cancel buttons have their usual meanings.

Using the FSM Design Wizard you can quickly define a new state ma-
chine, including its I/O ports.

File | Open [CTRL+O].

This option allows you to open an existing (saved) project and prompts
you to save changes made to the current project. It displays the Open
window (Figure 1-9) which is a typical Windows screen display.

Figure 1-8. Design Wizard - Machines Window
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1. Look in field allows you to select the project directory,

2. Upper level folder button ( ) allows moving one step up in the folder
hierarchy,

3. New folder button ( ) allows creating a new folder,

4. List/details buttons ( ) allow toggling between an abbreviated and
detailed display of the documents,

5. File name field is used for entering project’s name,

6. Files of type field allows viewing only files of the selected type.

All options of this window display are described in the Help menu, acti-
vated after clicking the Help button located in the Title bar.

Note: Since the OPEN window is a standard Windows screen, all its op-
tions are described in Windows user’s documentation and in Windows
Help.

File | Save.

This option saves the currently active document with the full file name
and date/time stamp. If the document is new (Untitled), the Save As win-
dow will be displayed instead and will allow entering the name of the
project. (See the next option)

File | Save As.

This option saves the active project with a new name. The Save As op-
tion is usually used to save the active document file under a new file
name. It produces a typical Windows’ Save As window (Figure 1-10).

Figure 1-9. Open Window.
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1. Save in field allows you to specify the project’s directory,

2. File name field is used for entering project’s name

3. Save as type field allows selecting the type of the saved file (the file
name extension).

Note: All saved documents have their file name extensions automatically
set to .ASF (ALDEC Schematic File).

File | Print [CTRL+P].

Figure 1-10. Save As Window.

Figure 1-11. Print Window.
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This option prints the active document. Selecting the Print option dis-
plays a typical Windows’ Print window (Figure 1-11).

1. Printer field options allow selecting the network printer . Its status,
type and port are automatically displayed below the printer name
field.

2. Print range field is for selecting pages to be printed

3. Copies field enables entering the number of printed copies.

File | Print Preview.

It displays the way pages will be printed. Selecting the Print Preview op-
tion displays a typical Print Preview window, similar to other Windows
programs (Figure 1-12).

The Print Preview screen allows previewing how the FSM project will be
printed.

File | Print Setup.

This option is used to select the printer and its options, such as the sheet
size and its orientation. The Print Setup window is shown in Figure 1-13.

Figure 1-12. Print Preview Window
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1. Printer field options allow selecting the printer; its status, type and
port are automatically displayed below the Printer name field.

2. Paper field allows selecting the Size of the sheet and its Source.

3. Orientation field allows selecting the orientation of printed page (por-
trait or landscape).

Note: The Printer Setup options are described in the Windows’ Help
menu.

File | Page Setup.

This option allows you to change the sheet size, its orientation and mar-
gins. The Page Setup window is typical for Windows applications (Fig-
ure 1-14).

Figure 1-13. Print Setup Window.
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File |Files List.

A list of up to four most recently edited documents is displayed in the
File menu. Double-clicking on the selected name opens the document.

File | Exit.

This option prompts you to save the design and quits the State Editor.

The Exit option ends the session. The FSM window (Figure 1-15) will
prompt you to save changes to an untitled document or exit the project
without saving the latest design changes.

Note: If ACTIVE-State Editor is invoked from the ACTIVE-CAD software,
then the program on Exit may display more message boxes prompting
you to save several of the project files. For details, see one of the next
chapters , where the integration with ACTIVE-CAD software is described.

Figure 1-14. Page Setup Window.

Figure 1-15. FSM SavePrompt Window.
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The EDIT Menu Options

Edit | Undo [CTRL+Z].

Undoes the last action. You can go back up to 512 steps.

Edit | Redo [CTRL+A].

Redoes (cancels) the previously undone action(s).

Edit | Cut [CTRL+X].

Cuts the selected items and puts them on the Clipboard.

Edit | Copy [CTRL+C].

Copies the selected items and puts them on the Clipboard

Edit | Paste [CTRL+V].

Inserts the Clipboard’s contents at the current cursor location (pastes
Copied or Cut items).

Edit | Delete [DEL].

Erases the selected items.

Note: The Cut, Copy, Paste and Delete options operate like any other
Windows programs.

If no selection is made - the Cut, Copy and Delete options will not be ac-
tive and will remain gray. Similarly, if nothing has been selected to Clip-
board - the Paste option will not be active and will remain gray.

There are three methods of objects selection:

1. To select an object, position the mouse pointer within its body and click
with the left mouse button.

2. To select several objects, click on each of them while holding the SHIFT
key depressed.

3. To select a group of objects, click at some point on the screen, and drag
the cursor to the opposite corner of the rectangle. When you release
the left mouse button, all objects within the rectangle will be selected
for subsequent cutting, copying or deleting.

Edit |Select All.

This option selects all items in the entire diagram.
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Note: The Cut, Copy, Paste and Delete options allow you to export your
FSM Project in the metafile format to all popular text editors via Clip-
board. However, since a purely graphical file will be created, all design
parameters will be lost in the process.

Edit | Symbol.

This option allows making changes to the port descriptions. The shape of
the symbol associated with the diagram and all ports can be seen in the
View Symbol window shown in figure 1-16.

Edit | Settings.

This option allows changes to Text, Line and Fill settings, which control
color, font type and size, and other attributes of diagram objects.

All diagram objects can be set to any value or parameter. For example,
the State object can be represented by a black circle filled with green
background and having a black State label:

Frame color = black (see Fill Bundles)

Fill color = green (see Fill Bundles)

Text color = black (see Text Bundles)

Objects, called Transitions (means Transition lines) are drawn between
states as Bezier Curves connected to States. They have their own graphi-
cal and logical attributes.

Figure 1-16. View Symbol Window.
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Graphical attributes can be defined using the Text, Line and Fill options
described below:

Note: The Text Settings screen is shown in the Figure 1-17. The Line
Settings and Fill Settings look similar to the display in Figure 1-17.

Edit | Settings | Text.

Changes text color, font size and other settings for:

1. Actions.

2. Conditions.

3. Declarations.

4. Labels.

5. State Labels.

Edit | Settings | Line.

Changes the line color for:

1. Errors.

2. Transitions.

Figure 1-17. Settings Window - Text Card.
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Edit | Settings | Fill.

Changes the fill and frame colors for:

1. Current State.

2. Ports.

3. States.

Note: Graphical attributes will be automatically saved with each docu-
ment file.

The SEARCH Menu Options
Search | Find String [Alt+F3].

This option finds the specified text within the entire project. Selecting it
displays the Find window (Figure 1-18).

If you enter a text in Find what field, ACTIVE-State Editor will search
the entire FSM project for that text. If the Match case option has been se-
lected, then the text will also be checked for the compliance with upper-
lower case letters. The operation of the Find window and its options is
similar to other Windows programs. Consult the Help menu for details.

Search | Find Next [F3].

This option repeats the last Find String (or Find Next) operation.

Search | Find and Replace.

Replaces the selected text with the desired text. Selecting this option dis-
plays the Replace window (Figure 1-19) which is similar in operation to
other Windows programs.

Figure 1-18. Find Window.
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Search | Previous error [Shift+F4].

This option displays sequentially all design errors which were detected
during the HDL Code Generation process in the last- to-first order.

Search | Next error [F4].

This option displays sequentially all design errors which were detected
during the HDL Code Generation process in the first- to-last order.

The View Menu Options
View | Zoom in [CTRL +].

Zooms the diagram to 200%.

View | Zoom out [CTRL -].

Zooms the diagram to 50%.

View | Zoom Select.

Selects zoom rectangle for continuous Zoom.

View | Page [PgDn].

Displays the entire design sheet.

View | Previous [PgUp].

Shows the previously visible part of the diagram.

Figure 1-19. Replace Window.
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View | Toolbars.

Shows a pull-down menu for toolbar display. See The Toolbars section in
this chapter for detailed explanations.

View | Status bar.

It shows or hides the status bar, which is located at the bottom of the
document’s window. When enabled, the status bar will display help mes-
sages, e.g. For Help press F1. The Help information or message is context-
sensitive.

There are four small windows located at the bottom right-hand corner of
the screen. They are VHDL/ABEL, OVR, CAP, and NUM windows, and
they are placed side by side horizontally. The windows will remain
blank if the listed options are not selected.

1. The VHDL/ABEL window displays which HDL option has been se-
lected for the HDL Code generation. Two options are available:
ABEL and VHDL. These options are selected from FSM Wizard, and
the Synthesis | Configuration options.

2. The OVR window displays the entry mode. It can be set to either IN-
SERT or OVERWRITE by pressing the Insert key.

3. The CAP window indicates the state of Caps Lock.

4. The NUM window shows the state of Num Lock.

View | Machine Frames.

Shows or hides frames of machines. This option displays a graphical
separation between the local Machines and the FSM Diagram, which in-
cludes all state machines.

Note: A Machine is distinguished from an FSM Diagram (or so called
FSM Design or FSM project) by a thin rectangle frame.

Figure 1-20. Status Bar.
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View | Grid.

Allows to set such grid options as Snap to Grid, Grid Spacing and the
Start Position coordinates (Figure 1-21 ).

View | Redraw [F10].

Redraws the entire window and refreshes the FSM project design, dis-
played on the monitor screen.

The Toolbars
ACTIVE State editor displays by default three toolbars docked as hori-
zontal or vertical bars at the main FSM document field edge. These three
toolbars are: Main, FSM and Draw and they are activated and deacti-
vated from the View | Toolbars option.

The Toolbars menu contains the following options:

1. Main.

2. FSM.

3. Draw.

4. Default Position.

By default, the Main toolbar is placed at the top of ACTIVE-State Editor
window, just below the menu bar. The FSM and Draw toolbars are

Figure 1-21. Grid Settings Window.
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placed on the left-hand side of the screen, just at the left FSM document
field edge.

Note: The toolbars can also be docked as horizontal or vertical bars or
sets of boxes anchored anywhere within the state machine window. To
move a toolbar, click in the close proximity of the toolbar button (outside
the button) and drag the toolbar to the desired new screen location. De-
pending upon its new position, the toolbar automatically changes its hori-
zontal/vertical orientation.

The Main Menu has considerable number of options. To simplify the use
of the FSM editor, the most frequently used operations can be activated
by clicking on buttons located within the three toolbars in Figure 1-22.

The Main Toolbar.

It is docked by default as a horizontal bar or a set of boxes at the top of
the ACTIVE-State Editor window, just above the FSM document field
edge. It contains the following tool-buttons:

Figure 1-22. Toolbars' "Anywhere" Positions.

Figure 1-23. Main Toolbar.
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The tool buttons are described in the left-to-right order:

r New [CTRL+N] - Creates a new document.
r Open [CTRL+O] - Saves the active document and opens an existing

document.
r Save [CTRL+S] - Saves the active document.
r Print [CTRL+P] - Prints the active document.
r Cut [CTRL+X] - Cuts the selected items and puts them on the Clip-

board.
r Copy [CTRL+C] - Copies the selected items and puts them on the

Clipboard.
r Paste [CTRL+V] - Inserts the Clipboard’s contents (pastes copied or cut

items).
r Undo [CTRL+Z] - Undoes the last action.
r Redo [CTRL+A] - Redoes (cancels) the previously undone action.
r Zoom in [CTRL +] - Zooms the diagram to 200%.
r Zoom out [CTRL -] - Zooms the diagram to 50%.
r Zoom Select - Selects zoom rectangle for continuous Zoom.
r Page [PgDn] - Shows the whole page.
r Generate HDL - Translates current diagram into HDL code.
r Synthesize - Starts the selected synthesis tool.
r View Report - Displays logic synthesis report.
r About State Editor - Displays the program information, its version

number and the copyright notice.
r Help - Invokes context-sensitive Help. Displays help for activated

buttons, menus and windows.

The FSM Toolbar.

It is docked by default as a vertical bar or a set of boxes on the left-hand
side of ACTIVE-State Editor window, just at the left edge of the FSM
document window. It contains the following tool-buttons:

The tool buttons are described in the left-to-right order:

r Select - Selects and edits. It allows such editing operations as drag,
delete, etc.

r State - Allows entering new machine states or “bubbles”.
r Transition - Allows drawing state transition lines.
r Condition - Allows to specify conditions that cause a transition to a

new state.

Figure 1-24. FSM Toolbar.
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r Entry Action - Adds/Edits entry action of a state. It sets all output ports
on the state entry.

r State Action - Adds/Edits state action of a state. It sets I/O ports upon
detecting a new state.

r Exit Action - Adds/Edits exit action of a state. It sets I/O ports on exit
from the selected state.

r Transition Action - Adds/Edits action of a transition. It sets I/O ports
upon detecting a state transition.

r Declarations - Adds/Edits machine or diagram declarations.
r Machine/Diagram Action - Adds/Edits machine or diagram actions.
r Input Port - Adds/Edits input ports. It is used for drawing input ports.
r Output Port - Adds/Edits output ports. It is used for drawing out-

put ports.

The Draw Toolbar

It is docked by default as a vertical bar or a set of boxes on the left-hand
side of the ACTIVE State Editor. It contains the following tool-buttons:

r Text - Places text string.
r Bezier Curve - Draws Bezier Curve.
r Circle - Draws Circle.
r Rectangle - Draws Rectangle.

Note: All elements drawn in the graphics mode do not have any electrical
properties.

The FSM Menu Options
Note: There is a direct correlation between the FSM Options chosen
from its Menu and the icon tools selected from the (vertical) FSM Toolbar.

FSM | Machines.

Selecting this menu will display a pull-down sub-menu, which will list
following items:

[machine names]
Add New

The first item lists Machine names in the current diagram (e.g. Sreg0,
Sreg1).

Figure 1-25. Draw Toolbar.
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If you want to add a new Machine you should make some space for it by
shrinking existing machine(s) outline. When you click on the Add New
option, the new, empty machine outline will appear. However, if there is
no place for a new Machine design then the window in Figure 1-26 will
appear.

If a new Machine design is allowed, a window or frame will appear, and
you will be able to enter //Declaration statements for the new machine
design.

Note: You need to keep track of the number of machine designs in your
FSM Diagram.

Let’s review the example of an FSM Design (FSM Graph) shown in Fig. 1-
27 (see the Applications Guide).

Figure 1-26. FSM Warning Window.

Figure 1-27. AIR_COND Design Diagram.
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FSM | Select.

Allows selecting objects and performing such editing operations as drag,
delete, etc. Using the Select option, you can select an object for editing,
draging, etc. The equivalent toolbar button is shown above.

Note: The mouse cursor changes its shape depending upon the selected
operation.

FSM | State.

Allows to add new State objects to machines. Typically, the state symbol
appears as a black circle filled with green and black symbol name. The
symbol name is automatically placed inside the symbol field. Initially,
the bubbles are named in sequence as S1, S2, etc. You can then edit these
names to the desired ones.

Note: The FSM Machine (finite state machine) is always in one of its mul-
tiple states.

If a condition is satisfied i.e. when a logical Boolean equation becomes
true then a transition from one state to another will occur.

Once the State option is selected, then each click of the left mouse button
will produce a new state symbol on the screen. Pressing the right mouse
button will return the FSM editor to the Select mode, which is the default
mode.

FSM | Transition.

This option is for drawing new state transition lines. It allows connecting
any two states with a line or curve - which is called the Bezier’s curve.

Note: You can edit the transition lines by dragging its middle-point loca-
tions or delete them by activating the Select toolbar button and then se-
lecting Edit | Delete options. To disconnect a transition line end, double
click at the selected transition line end. When a free-floating transition
line end marked with ⊗ symbol (open connection) appears, drag it to the
desired screen location.

FSM | Condition.
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Allows to specify the conditions that cause a transition from one state to
another. Using this option you can write a set of conditions at each transi-
tion line.

Note: A condition is the attribute of the transition line. It is displayed by
default in a dark violet frame around the condition text. The frame with its
condition text, is connected to the associated transition line by a thin line
displaying their logical association.

Attributes of the condition text can be set using the Edit | Settings and
Text bundles. For example, you can select Arial, 10, Italic, Underline for a
specific condition text.

The easiest way to learn this feature is by editing any of the design sam-
ples which are provided with ACTIVE-State Editor Applications Guide.

Note: Since the State Editor allows cutting, copying, and moving text via
Clipboard, you can edit the text with such text editors as Word for Win-
dows, etc.

To magnify a text selected for editing, drag the corner handles of its out-
line. The text font will automatically rescale to fit the new box outline.

FSM | Action.

Actions are the state and transition-associated operations. The I/O ports
may change their logical state upon detecting an Action. There can be
three (3) different actions associated with each state and one (1) associ-
ated with each transition.

Entry Action - Adds/Edits entry action of a state. It sets all output
ports on the entry to the selected state.

State Action - Adds/Edits state action of a state. It sets I/O ports
upon detecting a new state, which can be some time after the transition
to that state occurred.

Exit Action - Adds/Edits exit action of a state. It sets I/O ports upon
exit from the selected state.

Transition Action - Adds/Edits actions of a transition. It sets I/O
ports upon detecting a change on the transition line.
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Note: There can be only one action of each kind associated with a state
or transition!

For example, in the diagram shown in Figure 1-27 there is an entry action
associated with the FAN_ST state. You can add a state action or exit ac-
tion to this state. However, you cannot add yet another entry action.

Actions can be selected, dragged and edited, similarly to operations on
conditions.

Note: If an action is associated with a transition, it is called the transition
action .

There can be only one transition action for each transition!

A transition with its attributes (condition and a transition action) consti-
tutes an independent object, which can be disconnected from a state.
However, the condition and transition actions are unique for each transi-
tion, and without it have no meaning. The same is true for state actions.

Note: No action (entry, state, or exit) can be specified without a direct ref-
erence to the selected state or transition line. However, a transition line
without actions and conditions and a state without action are allowed!

An FSM diagram must consist of at least one Machine. A state and its
transitions can only be placed within a Machine schematic sheet. You
cannot connect states located in different Machine designs.

Note: Each Machine is delineated by a thin rectangular line. Several ma-
chines can share the same I/O pins but they cannot directly interact with
each other.

Note:
Object selecting - is performed by clicking within the object area.
Machine selecting - is performed by clicking within the machine rectangu-
lar outline.

Machine/Diagram Action.

Adds/Edits action of an individual machine or the entire diagram. Ac-
tions must be specified in reference to a Machine or to the entire FSM
Diagram. Clicking on the empty area inside the machine frame or at the
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top of the FSM diagram opens a frame for entering the Machine or FSM
Diagram action, respectively.

FSM | Declarations.

Adds/Edits declarations to machine or diagram.

ACTIVE-State Editor ä places the word: //DECLARATIONS right below
the Machine name. Everything you enter (states, transitions, actions, etc.)
is considered FSM declarations. Each declaration is a single entity which
can be entered by the user as a multiline declaration text. Declarations
may pertain to a selected Machine or to the entire FSM Diagram. For ex-
ample, to simplify conditions you can define auxiliary variable in the dec-
larations section and use it in any actions and conditions.

FSM | Input Port.

Adds/Edits input ports to the diagram; used for adding new input ports.

FSM | Output Port.

Adds/Edits output ports to the diagram; used for adding new output
ports.

Input and Output Port icons are automatically placed outside the particu-
lar Machine outline because ports are pertaining to the entire FSM Dia-
gram and not to its local Machine designs. Global variables are declared
in the same field as the Input/Output ports. Depending on the direction

Figure 1-28. State MachineGraph.
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of the information flow, ports can be defined as Input, Output or Bi-direc-
tional type.

An Input Port can be defined as Normal or Clock type.

Output and Bi-directional ports can be defined as Registered or Combi-
natorial type.

Note: The Normal port type is assumed if Clock checkbox remains empty!
The Registered output port will store an input signal on the active clock
transition.

When all ports of an FSM Diagram have been entered, start editing the
objects by selecting the Edit | Symbol option. In response, a window con-
taining the list of ports will be displayed . You will be able to change any
name by clicking within its field and editing it.

Clicking on the header fields allows to sort ports by Name, Direction or
Type of ports.

The Draw Menu Options

Draw |Text - Places text string.

Draw |Bezier Curve - Draws Bezier Curve.

Draw |Circle - Draws circles.

Draw |Rectangle - Draws rectangles.

All DRAW Menu Options correspond to the icons which are displayed in
the vertical Draw Toolbox. These tools and options allow for typical de-
sign editing operations such as drawing and writing within the FSM de-
sign area.

The SYNTHESIS Menu Options

Synthesis | Configuration.

It allows to select such synthesis options as the HDL language and the
logic synthesis tool vendor. Selecting this option displays the HDL Con-
figuration window shown in Figure 1-29.

1-32 The Draw Menu Options



ACTIVE-State Editor offers three HDL choices: ABEL, VHDL, and MINC-
DSL. They are listed in the Language field (Figure 1-29). ABEL is being
set as the default language. Since XABEL (Xilinx) is the only ABEL tool
supported by ACTIVE-State Editor, it will be automatically displayed in
the Tools field.

If you chose the VHDL option, a list of VHDL-compatible logic synthesis
tools will be displayed (Figure 1-30).

ACTIVE-State Editor currently supports the following logic synthesis
tools:

1. ASYL + (IST).

2. CORE (Exemplar).

3. XVHDL (Metamor).

Synthesis | HDL Code Generation [CTRL+H].

Automatically generates HDL Code for the selected logic synthesis tool.

Figure 1-29. HDL Configuration - ABEL Window.

Figure 1-30. HDL Configuration - VHDL Window.
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Note: You need to make sure that the selected logic synthesis tool is in-
stalled on your computer. Otherwise, you will not be able to further proc-
ess the generated HDL code!

Synthesis | Options ...

Customizes synthesis tools options for area, speed and compilation ef-
fort. If you have selected VHDL as your HDL platform then the [Synthe-
sis] Options window (Fig. 1-31) will appear.

The Compile field will allow converting the VHDL code into either a
Macro or a Chip. In addition, you can compile the code as XBLOX.

The Optimize field allows you to optimize the compilation process for
Area, Speed and Area/Speed.

The Effort Level field controls how much compilation effort will be put
into the netlist generation process.

After you have made your decision regarding the HDL language and the
logic synthesis tool, select the Synthesis | HDL Code Generation.

Synthesis | Synthesize.

Starts the logic synthesis process. It activates the logic synthesis tool and
its options that have been selected in Figures 1-29, 1-30 and 1-31.

Figure 1-31. METAMOR Options.
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Synthesis | View Report.

Displays the errors and other messages generated by the logic synthesis
process.

The PROJECT Menu Options

Project | Add to Project

Adds current diagram to the ACTIVE-CAD project resources.

Project | Create Macro

Creates ACTIVE-CAD macro from the current diagram.

Project | Update Macro

Updates macro after the changes made to the diagram.

The TOOLS Menu Options

Tools | Preferences.

Customizes configuration of the design graphics. Enables/disables text
scaling and State Codes display on the FSM diagram. These preferences
can be set directly in the window below (Figure 1-32).

Figure 1-32. Preferences - Graphics Card.
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Tools | Project Manager.

Activates Project Manager which controls other design tools and project
files.

Tools | HDL Editor.

Runs HDL Editor. It invokes the HDL Editor which displays the gener-
ated HDL Code. The editor will allow you to edit and analyze in detail
the HDL code.

Tools | Simulation.

Activates the logic simulator if a valid netlist has been loaded or gener-
ated (see ACTIVE-CAD Logic Simulator User’s Guide).

The Help Menu Options
r Help | Help Index - Lists Help topics.
r Help | Using Help - Displays instructions on how to use Help.
r Help | About State Editor - This option displays the information in

Figure 1-33.

Figure 1-33. About State Editor Window.
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Context Sensitive Menu

States, Transitions, Conditions, & Actions
Clicking the left mouse button creates actions such as placing or selecting
objects.

Placing mouse pointer over an object and clicking the right mouse button
activates context sensitive menus for the selected object.

Figure 1-34 shows a context sensitive menu for a state object.

Using the menu you can:

1. change the Border color of the State object,

2. fill the object with a color or disable filling,

3. choose the desired fill color,

4. set up the Trap state,

5. set up the Default state,

6. define or set up the State Properties (Figure 1-35).

Figure 1-34. State Context Sensitive Menu.
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Clicking the right mouse button within the Machine outline (border),
and selecting Properties option will display the Machine Properties win-
dow (Figure 1-36).

Transition Text & Transition Properties
Clicking the right mouse button on a transition object will display a con-
text sensitive menu for the Transition (Figure 1-37). This menu will al-
low you to change Color of the transition line, set the global exit for all
states and set a Priority level for the transition. Selecting the Properties
option will display the Transition Properties window (Fig. 1-38).

Figure 1-35. State Properties Window.

Figure 1-36. Machine Properties Window.
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Note: The priority level decides which of the transitions will take place,
should several of them come up at the same time. The priority level of 0
(the lowest) is not displayed on the screen.

The Transition Properties window (Fig. 1-38) allows selecting transition
properties:

1. select the starting point of the transition in the From field,

2. select the end point of the transition from the To field,

3. select the priority level for the transition in the Priority field,

4. click on OK button to complete the priority assignments.

Figure 1-37. Transition Context Sensitive Menu.

Figure 1-38. Transition Properties General Card.
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Note : Three buttons at the top of the properties window allow moving
throuogh the object hierarchy:
- left and right arrow buttons display the properties of objects on the
same hierarchy level,
- up arrow button displays the properties of higher level objects.

Clicking on the tabs in the Transition Properties window (Fig. 1-38) will
display other cards from that window.

r Graphics tab displays a card for color selection for for transition and
error lines.

r HDL tab displays a card for direct editing of Transition conditions
and Transition actions.

Placing the mouse pointer over text and clicking the right mouse button
will display context sensitive menu which is the same for all text objects
(Figure 1-39) .

You can select the text Color (Figure 1-40), Frame (framed or not
framed), and text Font (Figure 1-41). These are typical Windows options.

The Properties option in Fig. 1-39 refers to the selected object. Text itself
does not have any properties other than font and color.

Note: Text is used to define states, transitions, conditions and actions.
The Edit | Settings allows global settings of text parameters. The con-
text sensitive menu provides for local text settings.

Figure 1-39. Texts Context Sensitive Menu.
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Figure 1-40. Color Window.

Figure 1-41. Font Window.
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Condition Text & Condition Properties
Placing the mouse pointer over a Condition object and clicking the right
mouse button will display the context sensitive menu for the condition.
With the help of the menu in Figure 1-39 you can change Color of the
condition text. In addition, you can have it Framed or not. Also, you can
change the Font for the condition text, and select the Condition Proper-
ties window in Figure 1-42. Its Graphics card and Editor card are shown
in the Figure 1-42 and 1-43.

The Graphics card (Figure 1-42) allows assigning the text attributes de-
fined for the following objects:

1. Actions.

2. Conditions.

3. Declarations.

4. Labels.

5. State Labels.

Select a bundle from the Condition Properties window and click on the
Apply Now button to apply attributes.

The selected condition text can be edited in the Editor card window (Fig.
1-43). After editing the text, click on the Apply Now (or OK) button to
transfer the edited text to the FSM diagram.

Figure 1-42. Condition Properties Graphics Card.
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By placing mouse cursor over any port symbol and clicking the right
mouse button you can activate the context sensitive menu. This menu
will allow you to change the Port Color and Port Properties (Figure 1-
44).

The General card from the Port Properties window (Figure 1-44) allows
defining or redefining or the I/O ports parameters, including:

Figure 1-43. Condition Properties Editor Card.

Figure 1-44. Port Properties Window.
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1. the port Name,

2. type of the port: Input, Output, or Bi-directional,

3. type of Input port

a. Normal (the empty checkbox) or

b. Clock type,

4. type of Output or Bi-directional port:

a. Registered or

b. Combinatorial type.

The Apply Now (or OK) button saves your new setups. The Left and
Right Arrow buttons facilitate browsing of ports. The Up Arrow button
allows selecting higher hierarchical design levels.

The ‘DRAW’ Toolbar Context Sensitive Menu
Note: All operations performed with these options have no effect on the
electrical properties of the FSM diagram. Use these operations for “cos-
metic” improvement of the documentation only.

The Text Properties window is similar to the previously described Condi-
tion Properties window (Figure 1-42 and 1-43). Graphics card and Edi-
tor card are shown in the Figure 1-45 and 1-46, respectively.

Figure 1-45. Text Properties Graphics Card.
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Placing the mouse pointer within Bezier’s object area (curved line) and
clicking the right mouse button will display the menu in Figure 1-47.
You can select the Color option to change the Bezier curve’s color, or
Properties option to open Polyline Properties window (Figure 1-48). The
Graphics card allows selection of color for the transitions and errors.

Figure 1-46. Text Properties Editor Card.

Figure 1-47. Bezier Curves Context Sensitive Menu.
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The context sensitive menus for Circle (Ellipse) and Rectangle objects en-
tered in the Draw mode are similar to Figures 1-47 and 1-48. The Graph-
ics card (Figure 1-49 and 1-50) allows color settings, similarly to the Edit
| Settings option.

Figure 1-48. Polyline Properties Graphics Card.

Figure 1-49. Ellipse Properties Window.
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Note: Clicking on the Draw type object with the right mouse button al-
ways invokes a menu with Properties option. Selecting that option dis-
plays Polyline Properties, Ellipse Properties or Rectangle Properties
window, depending on the object that has been clicked. These windows
operate similarly to other FSM properties windows.

Figure 1-50. Rectangle Properties Window.
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The FSM Diagram Context Sensitive Menu.
Placing the mouse cursor over the FSM Design border or any Machine
thin frame, and clicking the right mouse button, will display a context
sensitive menu window (Figure 1-51).

The menu in Figure 1-51 allows selecting:

1. Border color.

2. Filled (or unfilled) design border.

3. Fill Color of the border.

4. Properties (of the Machine).

Selecting the Properties option in Figure 1-51, displays the Machine Prop-
erties window. The General card (Figure 1-52) allows to edit:

1. Machine name (Name field).

2. Active clock edges (Clock field).

3. Encoding process (Encoding field).

Figure 1-51. FSM Diagram Context Sensitive Menu.
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The Reset card (Fig. 1-53) allows to select the reset signal and its effect on
the FSM diagram behavior.

The Defaults card (Fig. 1-54) allows to set the initial design conditions.
For example, you can force a trap state or leave the design in the don’t
care state (unknown).

Figure 1-52. Machine Properties General Card.

Figure 1-53. Machine Properties Reset Card.
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Figure 1-54. Machine Properties Default Card.
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Basic Elements of the Windows ‘95 interface
The Windows ‘95 main screen displays the following items:

r small square pictures called Icons,
r horizontal bar at the bottom of the screen, called Taskbar,
r rectangular button on the taskbar with the Windows logo and ‘Start’

text, called Start Button,
r small arrow that changes its position when you move your mouse,

called Mouse Pointer.

You can also see large rectangular areas with their own icons, text and
buttons; they are called Application Windows.

All these items are described in the Windows ‘95 documentation and you
should refer to the original Windows ‘95 manual for more details.

Most operations are performed with the mouse device. The mouse
pointer follows the mouse movements and allows for pointing at screen
objects.

r Placing mouse pointer over an object and clicking the left mouse button,
selects the object.

r Double clicking on an object (i.e. clicking twice, quickly) with the left
mouse button invokes an action associated with that object (invokes a
program, displays a document).

r Clicking on an object with the right mouse button displays a menu of
options or actions for the selected object.

All documents and programs in the Windows ‘95 operating system are
usually displayed as small square pictures, called icons. For your conven-
ience, related icons are usually grouped into folders, represented by an
icon depicting paper folder. When the folder is closed, you cannot see its
icons. Double-clicking on the icon opens the folder, which takes the
shape of the window with Title bar at the top, Horizontal Menu Bar be-
low, and area filled with icons representing folders, programs and docu-
ments. Windows usually have three buttons in the top right-hand corner:

r Minimize button (the first from the left) reduces the entire window to
a button on the taskbar; clicking that button with the mouse restores
the window to its original size.

r Maximize/normalize button (the middle one) toggles the window
between partial and full-screen display.

r Close button (the right button) completely closes the window.
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1. Some windows may have the Help button ( ).Pressing that button and
then clicking on an object will display a short information on that ob-
ject.

2. When a window is too small to show the entire document, scrollbars
will appear on the right and bottom edge of the window. They con-
tain arrow buttons that allow moving the window over the docu-
ment and scroll box that shows current position of the window in the
document.

3. Both horizontal menu bar and vertical pull-down menus work the
same: selecting an option starts an immediate action.

4. Some options may have shortcut keys or hotkeys assigned to them
(they are displayed with the option). Pressing shortcut key invokes
the action associated with the option, even if the option is not visible
on the screen.

5. When the option name is displayed in gray it means that the option is
inactive at the moment and cannot be selected.

6. Some menu options and buttons may have one letter underscored - in-
stead of clicking in that option you can press the underscored letter
on the keyboard while holding the ALT key down.
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GLOSSARY
ACTIVE-State Editor a graphical state machine-editor developed and

manufactured by ALDEC Co. Inc. It generates
ABEL and VHDL design files from graphical de-
signs representations.

ACTIVE-CAD a device and system-level ESDA tools for entering
schematics, FSM diagrams, and simulating the
entries.

F SM (Finite State Machine) a digital design with a finite number of logical
states.

FSM Design Wizard user guidance program for ACTIVE-State Editor.

HDL Code Generator a program which creates an HDL text description
of an FSM or flowchart based project.

Netlist a file containing binary or text data regarding
electronic design . The file lists all elements,
their connections and properties.

Schematic Capture a program for entering graphical design repre-
sentation. Generally, each element represents a
physically equivalent item.

Symbol Editor a program which comes as a part of Schematic
Capture and allows for creating graphical repre-
sentations of physical objects.

Toolbars groups of icons for speedy selection of programs
and options.
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Basic Vocabulary & Commonly Used Abbreviations
.ASF = ALDEC Schematic File standard name extension

ABEL - An HDL Language (Hardware Description Language) devel-
oped by Data I/O.

ACTIVE-CAD - ESDA product line developed by ALDEC.

ALDEC - Automated Logic Design Company, Inc.

BBS transfer - transferring data via bulletin-board service.

CAE - Computer Aided Engineering - designing with the aid of com-
puter.

CAP = Caps mode = Capital Letters mode.

CLK - clock.

CYPRESS - An abbreviated name of the Cypress Semiconductor com-
pany.

DOWNLOAD - loading a file for processing by the computer.

E-MAIL - electronic mail.

EDA - Electronic Design Automation.

EPLD - Electrically Programmable Logical Devices.

FAX - facsimile equipment for electronic transition of documents.

FPGA - Field Programmable Gate Array.

FSM = Finite State Machine - this is a generic term for the state machine
editor.

I/O = Input/Output.

Logic synthesis - A process which converts HDL design files into a
netlists for selected devices.

NUM = Numerals - Num Lock’s key depended mode.

OrCAD - Name of a CAE company.

OVR = Overwrite mode.

PWR - power.

R = Registered; a trade name registered in The Registration Office.

RPM - Revolutions per minute.

State Editor = State Machine Editor.

TIM - timer.
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TM = Trade Mark.

TMP - temperature.

VHDL - 1076-IEEE hardware description language.

ViewLogic - A name of an EDA company.

XACT - An FPGA layout tool manufactured by Xilinx.

XCHECKER - An FPGA layout support tool manufactured by Xilinx.

XILINX - A name of an FPGA manufacturer.

XNF netlist, netfiles - Netlist format defined by XILINX.
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Main Menu Command Index
A List Of Commands Available From Main Menu Options & Toolbars:

About State Editor - Displays the program information, its version
number and the copyright notice.

Action - an FSM pull-down menu option, the basic name for the group of
commands

Add to project - Adds a diagram to the current project.

Bezier Curve - Draws Bezier Curve.

Circle - Draws circle.

Condition - Adds/Edits condition of a transition; allows to specify the
conditions that cause a transition to a new state.

Configuration - Customizes synthesis options.

Copy [CTRL+C] - Copies the selected items and puts them on the Clip-
board.

Create macro - Creates macro from the current diagram.

Cut [CTRL+X] - Cuts the selected items and puts them on the Clipboard.

Declarations - Adds/Edits declarations to machine or diagram.

Delete [DEL] - Erases the selected items.

Draw (main menu options)

Edit (main menu options)

Entry Action - Adds/Edits entry action of a state. It sets all output ports
on the state entry to a new state.

Exit - Quits the application; prompts to save documents.

Exit Action - Adds/Edits exit action of a state. It sets I/O ports upon exit
from the selected state.

File (main menu options)

Fill bundles - Changes fill bundles settings.

Find Next [F3] - Repeats the last find\Find Next.

Find String - Finds the specified text.

FSM (main menu options)

Graphics - Bezier Curve - Draws Bezier Curve.

Graphics - Circle - Draws Circle.
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Graphics - Rectangle - Draws Rectangle.

Graphics - Text - Places text string.

Grid - Sets grid options.

HDL Code Generation [CTRL+H] - Generates HDL Code.

HDL Editor - Runs HDL Editor.

Help (main menu options)

Help - It is a context-sensitive Help. Displays help objects pointed by the
mouse cursor.

Help Topics - Lists Help topics.

Input Port - Adds/Edits input ports; used for drawing new input ports.

Line bundles - Changes line bundles settings.

Machine Frames - Shows or hides frames of machines.

Machine/Diagram Action - Adds/Edits actions of a machine or diagram.

Machines - (an FSM pull-down menu option)

New [CTRL+N] - Creates a new document.

Next error [F4] - Shows the next error found during HDL generation.

Open [CTRL+O] - Saves the active document and opens an existing docu-
ment.

Options (main menu options)

Output Port - Adds/Edits output port to the diagram; used for drawing
output ports.

Page Setup - Changes paper size.

Page [PgDn] - Shows the whole page.

Paste [CTRL+V] - Inserts the Clipboard’s contents (pastes copied or cut
items).

Preferences - Customizes configuration.

Previous - Shows the previously visible part of the diagram.

Previous error [Shift+F4] - Shows the previous error found during HDL
generation.

Print [CTRL+P] - Prints the active document.

Print Preview - Displays (full) pages as they will be printed.

Print Setup - Changes the printer and printing options.
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Project (main menu options)

Project Manager - Activates Project Contents Manager.

Recent File(s) - Opens one of four recently edited diagrams.

Rectangle - Draws rectangle.

Redo [CTRL+A] - Redoes (cancels) the previously undone action.

Redraw [F10] - Redraws the entire window.

Replace - replaces found text with thw other.

Save [CTRL+S] - Saves the active document.

Save As - Saves the active document with a new name.

Search (main menu options)

Select - Selects and edits; allows such editing operations as drag, delete,
etc.

Select All - Selects all items in the current field.

Settings - Chooses Text, Line and Fill bundles settings.

Simulation - Starts simulation.

State - Adds states to machines; it is used for entering the machine states
or “bubbles”.

State Action - Adds/Edits state action of a state. It sets I/O ports upon
detecting a new state.

Status bar - Shows or hides the status bar.

Synthesis (main menu options)

Synthesis Tools Options ... - Allows selection of synthesis tool options.

Synthesize - starts synthesis tool

Text - Places text string.

Text bundles - Changes text bundles settings.

Toolbars - (a View pull-down menu option).

Transition - Adds transition to machines; it is used for drawing state
transition lines.

Transition Action - Adds/Edits action of a transition. It sets I/O ports
upon detecting a state transition.

Undo [CTRL+Z] - Undoes the last action.

Using Help - Displays instructions on how to use Help.
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View (main menu options)

View Report - Displays a report listing the compilation flow and errors.

Zoom in [CTRL +] - Zooms the diagram to 200%.

Zoom out [CTRL -] - Zooms the diagram to 50%.

Zoom Select - Selects zoom rectangle for continuous Zoom.
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Chapter 2

ACTIVE-State Editor Applications Guide

Introduction
The state machine editors allow you to enter your designs in graphical
form. Used quite widely in the 50’s, the state machine editors came back
in the 90’s to simplify the complex designs through graphical design rep-
resentation.

The basic premise of the new generation of the state machine editors is
that you need only to enter the key information. All details are automat-
ically done for you, including:

r checking for conflicts in your statements and expectations

r automatic VHDL and ABEL code generation from the FSM graphs

r animation of the graphs for better understanding of information flow

Since today’s technology involves complex relationships between data
and control signals, ACTIVE-State Editor allows you to enter these signal
conditions and relationships in an efficient and easy to understand man-
ner.

This Tutorial allows you to get a quick grasp of the ACTIVE-State Editor
features. Several examples with increasing complexity will teach you the
basics on how to use the state machine editor.

Basic Vocabulary
r ABEL; a hardware description language developed by Data I/O



r ACTIVE-State Machine Editor; a graphical state machine editor manu-
factured by ALDEC. It generates ABEL and VHDL design files from
graphical designs.

r FSM (Finite State Machine); a generic term for state machine editor

r Logic synthesis; a software product that converts VHDL and ABEL de-
sign files into a netlist for a target ASIC or FPGA physical implemen-
tation

r State Machine Editor; a graphical design entry tool which allows to de-
scribe the relationships between the input and output signals with
the help of ‘state’ bubbles and conditional transitions between the
states.

r VHDL; 1076-IEEE hardware description language

What Do You Need To Know About VHDL?
Since the state machine editor automatically generates the VHDL code
from the graph, you need to learn only minimum information about the
VHDL syntax:

r Signal types - how to define single bit signals and buses
r Operators - what operators are allowed and what they do
r Expressions - used for testing signal conditions and signal value as-

signment

ACTIVE-State Editor allows you to generate complex VHDL designs
without extensive VHDL language knowledge. If you learn the basic
VHDL statements listed below, you will be able to design fairly complex
VHDL state machines. The enclosed state machine examples will clarify
the use of the VHDL syntax statements. The examples listed below have
been taken out of the FSM graphs presented in the following sections.

Signal Types

r Bit - any signal and port name are automatically considered a single
bit type signal, e.g. FAN, FAST_CLK, Reset, preset, ctrl_on are exam-
ples of single bit “entities.” Only ‘0’ and ‘1’ logical values are al-
lowed.

r Bit_vector- is used to describe a bus signal. Signals such as
ADDR[0:7] or video[1:16] are called “bit_vectors.” Any time you en-
ter such a symbol in the symbol editor or in Wizard, it will automat-
ically be compiled by the state machine editor into the VHDL
“bit_vector” entity.
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NOTE: For bit type signal you must use ‘0’ and ‘1’ as its value. You can-
not enter 1s and 0s without the apostrophe markers.

VHDL also recognizes Boolean, Integer, Std_logic, Std_logic_vector and
other types but you do not need to be concerned with them in typical
state machine designs. For all practical reasons, you may forget about
these types.

Operators

The basic operator classes are listed below. Their operation and use are
implied by their names.

r Logical - and, or, nand, nor, xor, not
r Relational - =(equal), /=(not equal), < (less than), <=(less than or equal),

>(grater than), >=(greater than or equal)
r Assignment - <= ; this operator has a signal (entity port) on the left-

hand side, and a logical expression such as ‘0’, ‘1’, B, C, etc. on the
right. The assignment operator(<=) is automatically differentiated from the
relational operator <=(less than or equal) by the VHDL compiler.

Expressions

There are only two kinds of VHDL expressions; (1) expressions that test
for signal conditions and (2) expressions that assign logical states to enti-
ties (e.g. output ports).

r Condition expression - using logical or relational statements it tests for
certain conditions in the design. For example, ON_OFF=’1’ and
TMP3=’1’ will test when both signals have logical ‘1’. TMP1=’0’ will
test for condition when input signal TMP1 is at logical ‘0’. You can have
spaces between “=“ sign and other parameters in the statement. These
expressions are written directly into the Transition lines between ma-
chine states.

r Action assignment - forces the desired value into the signal (entity
port). For example FAN<=’1’ will force value ‘1’ into the FAN out-
put port. These statements are written directly into the associated
machine state bubbles.

Since ACTIVE-State Editor allows you to write the above expressions di-
rectly on the state diagram, this cuts on editing and minimizes the
number of errors.

Practicing with the enclosed examples will build your confidence in the
VHDL design tools. For more information, read some basic books on
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VHDL. WARP VHDL Synthesis Reference from Cypress Semiconductor
(TEL. 408-943-2600) has an excellent chapter on VHDL language.

Drawing State Machines With The FSM Wizard
An FSM diagram can be started from either from the FSM Design Wiz-
ard icon or system level ACTIVE-CAD software. Since designers are typi-
cally using the system level tools, most of our effort will be devoted to
FSM designs from the ACTIVE-CA design framework. Designing an
FSM graph from Wizard will be covered in a cursory manner.

FSM Design Wizard
Clicking on the finite state machine (FSM) icon, representing ACTIVE-
State Editor, activates the State Editor window which simplifies design
entry (Figure 2-1). It allows you to open an existing diagram or start a
new one. Clicking on the Use FSM Design Wizard button displays De-
sign Wizard Welcome screen; pressing Next> on that screen opens a new
window for selecting the HDL language (Figure 2-2).

Selecting HDL Language

The FSM Design Wizard window(Figure 2-2) allows you to select either
ABEL or VHDL for assignments and statements on the design graph. To
confirm your HDL language selection, click on the Next button. ACTIVE
State Editor will store your selection and automatically open the FSM
Design Wizard-Ports window for entering state machine ports.

Figure 2-1. Design Entry Options.
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Entering Input Signals

Clicking on the Next button in the FSM Design Wizard window acti-
vates the FSM Design Wizard-Ports window (Figure 2-3) which allows
selecting port names, their I/O direction and function.

1. To enter an input port, click on the New button and enter the port
name in the Name field.

2. Next, select the I/O port’s direction (Input). If the input port is a clock,
then you need to click on Advanced button and check the Clock box.

Figure 2-2. Selecting The HDL Language

Figure 2-3. FSM Design Wizard - Entering Ports
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Entering Output and Bi-directional Ports

The FSM Design Wizard-Ports window (Figure 2-3) provides for enter-
ing the ports’ name, itsr I/O direction and function.

1. To enter an output or bi-directional port, click on the New button and
enter the port name in the Name field.

2. Next, select the I/O port’s direction (Output or Bi-directional). You
may also check off either the Registered or Combinatorial box in the
window that appears after clicking on the Advanced button. In re-
sponse, FSM will automatically store these outputs in its internal
latches or produce them directly from combinatorial logic outputs.

Editing I/O Ports

1. To delete a port, select it in the Port Listing field with the mouse cursor
and click on the Delete button.

2. To modify an I/O port, select it in the Port Listing, field and when it
appears in the Port Name field, select the new parameters.

Entering Bus names

To enter a bus, first enter its name, and then click on the Range buttons
to set the upper and lower limit (range) bus signals. You may also add
the range in the square brackets after the bus name. ACTIVE State Editor
will automatically create the specified bus port.

Example 1:

Using the described above methods, enter the following port names and
their characteristics:

r Data_end; output, registered
r Data_out; output, registered
r Data_start; output, combinatorial
r Enable; input
r Hi_clock; input, clock
r Reset; input
r Video_In; input

A sample screen with the above listed ports is shown in Figure 2-4.

2-6 FSM Design Wizard



Multiple State Machines

ACTIVE-State Editor allows you to enter multiple FSM designs for a sin-
gle device (for the set of device pins that you have entered above). Click-
ing on the NEXT button in the FSM Design Wizard-Ports window
(Figure 2-4), activates the FSM Design Wizard-Machines window (Fig-
ure 2-5). Select in that window the number of concurrent state machines
by clicking on the appropriate fields (One, Two, Three or Four).

To select more than four state machines, click on the More option and en-
ter the number of concurrent state machines in the field to the right.

Figure 2-4. An Example Of Port Entries.

Figure 2-5. Selecting The Number Of FSM Designs
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When finished selecting the number of state machines, click on the Fin-
ish button. In response, ACTIVE State Editor will produce a display that
will allow for entering the selected number of independent state ma-
chines.

To name each individual state machine, place the mouse cursor on the
automatically assigned name (Sreg1, Sreg2, Sreg3, etc.) and click the left
mouse button.. The first click will put a red frame around the state ma-
chine name and the second click will display an editing cursor. Enter the
desired name. To complete the editing, place the mouse cursor outside
the editing area and click the mouse button.

Enter as many independent FSM design names as you may need. Un-
used or empty FSM designs will not foil the HDL compilations.

Entering An FSM Diagram Under The Wizard
If you click on the Finish button in the FSM Design Wizard-Machines
window (Figure 2-4) , a new screen will appear, and it will lists all the sig-
nals and clocks that you have entered in the previous steps. Figure 2-6
shows the port assignment for Example1.

By selecting the buttons on the left-hand side of the screen you will be
able to draw the state bubbles, transitions lines between bubbles. You
will also be able to assign the desired values to state signals and logical
or HDL expressions to transitions. Since this process is described in de-
tail in reference to Figures 17 - 24, please refer to these figures for more
details.

Figure 2-6. State Machine Entry Screen.
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System-Level FSM Design Process
ACTIVE-State Editor is a part of the ACTIVE-CAD set of EDA tools
which allow for direct schematic, HDL, VHDL and other forms of design
entry. Working with a software that provides for a total design solution
has its benefits:

r consistent top-down system design
r design block interfaces are clearly defined
r inter-block signal integrity is enforced
r all design tools have similar user interface

To effectively design complex systems follow this procedure with AC-
TIVE-CAD:

1. Start a top-level schematic sheet.

2. Place all major design blocks as empty symbols.

3. Interconnect the empty symbols

4. Perform detailed block designs in VHDL, state machine, etc.

5. Simulate the functional operation of each individual block

6. Simulate the top-level functional design

7. Layout the device(s) and verify their timing

8. Verify the top-level design timing

We will follow the above procedure with one example comprised of two
state machine designs:

AIR_COND System-Level Design
This is a system-level design (top-level schematic) that is comprised of
two devices:

1. CONTROL1 ; state machine design with VHDL syntax

2. CL_CTRL2 ; state machine design with ABEL syntax

The design dependencies are as follows:

AIR_COND ; top level design

CONTROL1 ; a device to be used at the system level, it may contain several
state machines, such asfastcooling,etc.
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fastcooling ; the name of the state machine design within the CONTROL1 de-
vice

CL_CTRL2 ; an independent operating device

CONTROL1

This design is an air-conditioning system operating as follows:

1. After the ON-OFF push button switch is activated, a fan is turned on if
the temperature is over 80 degrees F.

2. If the fan is not able to bring the temperature down to below 78 F
within 10 minutes, the fan is turned off and a cooling system is
turned on.

3. If at any time the temperature falls below 65 F, the cooling system
and/or fan are turned off.

CL_CTRL2

This control system is optimized for energy efficiency. It is described in
more detail in the Sample FSM ABEL Design chapter.

Create Top-Level Schematic Sheet
Using the procedures described in the Schematic Editor User’s Guide, start
a new project (e.g. AIR_COND) and open its first schematic sheet (e.g.
AIR_CON1.SCH), as shown below. To enter an empty symbol at the top-
level schematic, select the Symbol Editor option from the Options menu
(Figure 2-7).
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Edit Block Symbol In Symbol Editor
Selecting the Symbol Editor option from the Options menu displays the
ACTIVE-CAD- Symbol Editor window. Select the New option from its
File menu. When ACTIVE-CAD responds with the New Symbol win-
dow (Figure 2-8), enter CONTROL1 in the Symbol field and select (click
on) AIR_COND from the Library menu. Click on the OK button to close
the New Symbol window. In response, the ACTIVE-CAD - Symbol Edi-
tor window fills with graphics and options (Figure 2-9).

Figure 2-7. Schematic Editor Options Menu.

Figure 2-8. Entering A New Symbol.
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If you wish to move the symbol box, click within the blue symbol outline
and drag it to a new location. To accommodate large number of pins and
their long nomenclature, you need to expand the box by placing the cur-
sor on its blue outline and (when the double-pointed arrow appears),
dragging it to the desired location.

To enter pin names and numbers, click on the PIN button within the
symbol editor’s toolbox (Figure 2-10). In response, ACTIVE-CAD dis-
plays the Add Pin window (Figure 2-9) for entering the pin name and
number and its graphical shape. To accommodate long pin names, you
may need to drag the symbol outline to enlarge it.

Figure 2-9. Symbol Editor Setup.

Figure 2-10. Symbol Editor’s Toolbox.
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When adding pins in the Add Pin window, you must select as a mini-
mum:

r pin name
r I/O direction (input, output, etc.)
r graphical look (CLK, Line, dot, etc.)

For full compliance with the follow-on examples, enter the pin names
listed in the figure below (Figure 2-12). For more information on Symbol
Editor, read the Schematic Editor User’s Guide.

QUICK REVIEW OF SYMBOL EDITOR OPERATIONS

r Define PWR pins as INPUT if you want them visible. Assigning to them
the PWR status (in Pin_Type field in Figure 2-11) will make them
invisible.

Figure 2-11. Entering Symbol Pins.

Figure 2-12. CONTROL1 Symbol Pins Listing.
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r Use the Repeat option for signal names with incremental names
(TMP1, TMP2, TMP3...). You do not have to enter the full name (TMP1).
Entering TMP and then pressing the Repeat button will automatically
generate the TMP1 pin name. You need to enter the number only if you
start the count from zero, e.g. TEMP0 will automatically increment the
pin count from 0.

r The pin shape has no meaning in the logical model behavior. It is only
a graphical reminder of the pin’s function, which is defined by its
VHDL model.

r All operations are performed by clicking on the desired pin. When it
turns red, you can edit it in the appropriate field like Name or
Number and drag it to a new location on the symbol outline.

Place The New Symbol On The Schematic Sheet
After you have saved the CONTROL1 symbol in the symbol editor, it
will be added to the project library and will be listed together with all
other symbols in the SC Symbols list of the schematic editor. To display
the SC Symbols table, select the Symbols icon from the toolbar. Using
the editing options, place the newly created symbol on the top-level sche-
matic sheet.

Invoke the hierarchical ‘H’ cursor {Ctrl H} or select the Hierarchical
Push/Pop option from the Hierarchy menu. Next, click with the ‘H’ cur-
sor over the CONTROL1 symbol.

Figure 2-13. An Empty Block Symbol Placement.
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Since the selected symbol is empty, ACTIVE-CAD will display Select
Object Type window and will prompt you for entering the design type
that will be stored in the symbol (Figure 2-14). You need to select one of
the following types:

r Schematic Sheet; for entering gates, cells and macros, etc.
r FSM Description; for entering design bubble diagram
r HDL Description; for entering designs in HDL format.

Should you select the HDL description option, you must in addition select
the HDL language type. All HDL languages are listed in the field below
(ABEL, VHDL and VHDL Shorthand). The VHDL Shorthand is a subset
of the 1076 IEEE VHDL, which has been used by ALDEC and ACTIVE-
CAD users to write their IC models.

To enter a state machine design, select the FSM Description option and
click on the OK button. In response, ACTIVE-CAD will display the FSM
Design Wizard title page (Figure 2-15).

Figure 2-14. Empty Block Symbol Design Type.
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Clicking on the Next button will display a screen for selecting the HDL
language to be used for entering state machine diagram (Figure 2-16).
Currently, you can choose either ABEL or VHDL. Please choose VHDL
to comply with the following examples.

The Next button activates the FSM Design Wizard-Ports window (Fig-
ure 17). This window allows you to enter I/O signals and define their
characteristics.

Figure 2-15. FSM Design Wizard Title Page.

Figure 2-16. FSM Design Wizard: HDL Selection
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Selecting HDL Language
Clicking on the Advanced button in the FSM Design Wizard window ac-
tivates the Advanced Options window (Figure 2). You can select from
that window either ABEL or VHDL as the design description language.
Click on the selected HDL prompt (ABEL or VHDL) and then click on
the OK button to complete the HDL language selection.

Entering Input Signals
To enter an I/O port, click on the Next button in the FSM Design Wiz-
ard window. In response, ACTIVE-State Editor displays the FSM Design
Wizard-Ports window (Figure 3) for selecting the ports’ name, their I/O
direction and function.

Since the port names have been entered during the symbol editing (Fig-
ure 12), they are automatically be listed in Figure 2-17. You need to re-
view these signals and assign to them the proper I/O port properties:

r click on the top-most signal name listed in Figure 2-17. If the port’s
parameters (input, output, bi-directional, latched, non-latched and
clock) are correct, skip to the next signal name. If the port’s parameters
are incorrect, select the appropriate parameters and click on theChange
button.

Figure 2-17. FSM Design Wizard: Entering Ports
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r all output signals need to be checked for “latched” and “non-latched”
parameter. Any time you change this parameter, you need to click on
the Change button.

r If you enter a new port in Figure 2-17, it will automatically be added
to the symbol. If you need to reposition the automatically added pin
on the symbol outline, select the symbol editor and manually edit the
symbol pins.

If you plan ahead, you should know all pin names beforehand and be
able to enter them in Symbol Editor. If you want to add some new pins
in the FSM editor, you need to follow this procedure:

1. To enter an input port, click the mouse cursor in the Port Name field
and type the port’s name.

2. Next, select the I/O port’s direction (Input). If the input port is a clock,
then you need to check off the Clock box.

3. After the port’s name and its I/O characteristics have been defined,
click on the Add button. The port’s name will automatically be trans-
ferred into the Port Listing field that lists all I/O ports.

Entering Clock Signals
If the input signal is a clock, you must select the Clock option in the FSM
Design Wizard-Ports window and click on the Change button. This will
convert the signal into a clock. It will be treated by the FSM editor as a
special state machine signal.

Entering Output and Bi-directional Ports
1. To enter an output or bi-directional port, click the mouse cursor in the

Port Name field and type the port’s name.

2. Next, select the I/O port’s direction (Output or Bi-directional). You
also to check off either the Latched or Non-latched box. In response,
FSM will automatically store these outputs in its internal latches or
produce them directly from combinatorial logic outputs.

3. After the port’s name and its I/O characteristics have been defined,
click on the Add button. The port’s name will automatically be trans-
ferred into the Port Listing field that lists all I/O ports.
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Entering Bus names
To enter a bus, first enter its lowest order bus name, and then click re-
peatedly on the Add button. ACTIVE State Editor will automatically cre-
ate new I/O ports with names incremented by ‘1’.

Editing I/O Ports
1. To delete a port, select it in the Port Listing field with the mouse cursor

and click on the Delete button.

2. To modify an I/O port, select it in the Port Listing, field and when it
appears in the Port Name field, select the new parameters. To con-
firm the changes, click on the Change button.

The I/O ports are selected for the entire FSM design which may include
several independent state machine designs. To select the number of inde-
pendent state machines, click on the Next button. In response, ACTIVE-
CAD displays a window for selecting the number independent state
machine designs (Figure 2-18). Select the number of concurrent state ma-
chines by clicking on the appropriate fields (One, Two, Three or Four).

To select more than four state machines, click on the More option and en-
ter the number of concurrent state machines in the field to the right. Af-
ter selecting the number of state machines, click on the Finish button. In
response, a screen with the selected number of state machines will ap-
pear (Figure 2-20). You will be able to edit each section individually.

Figure 2-18. Selecting The Number Of FSM Designs.
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To name each individual state machine, place the mouse cursor on the
automatically assigned name (Sreg1, Sreg2, Sreg3, etc.) and click the left
mouse button.. The first click will put a red frame around the state ma-
chine name and the second click will display an editing cursor. Enter the
desired name. To complete the editing, place the mouse cursor outside
the editing area and click the mouse button.

Enter as many independent FSM design names as you may need. Un-
used or empty FSM designs will not foil the HDL compilations.

Entering The State Machine Designs
To simplify the arrangements of toolboxes, click on the View/Toolbars
menu. A menu similar to the one below (Figure 20) appears.

Figure 2-20. The State Machine Entry Window.

Figure 2-19. Arrangement Of Toolbars.
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Select allows editing operations such as drag, delete, etc.

State used for entry the machine states or “bubbles

Transition used for drawing state transition lines

Condition allows to specify the conditions at each state

Entry Action sets all output ports on state entry

State Actions sets I/O ports on detecting new state

Exit Actions sets I/O ports on exit from the state

Transition Action sets I/O ports on detecting a state transition

Input Port used for drawing input ports

Output Port used for drawing output ports

Table 1. Editing Control Bars.

Zoom In

Zoom Out

Continuous Zoom

View (full) Page

Table 2. Display Control Bars.

Entering Machine States

Activate the State toolbar and click left mouse button in three (3)
different places on the state machine diagram, as shown in figure below
(Figure2-22 ). Note that the machine states are numbered automatically
from S1 through S3.
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Editing Machine States

To change a name of a machine states (e.g. S3 in Figure 2-22), click on it.
A set of editing markers will appear around the selected state symbol.
Clicking inside the symbol S3 will create a white editing area. Delete the
S3 name with the help of the BkSp or DELETE keyboard keys and enter
COOL_ST as the new machine state name.

If the state machine bubble is too small for you to see, activate on the
Zoom toolbar at the top of the screen and pressing the left mouse button
drag a dotted-line square around the state machine name. When you re-
lease the mouse button, the S3 bubble expands, as shown below (Figure -
2-21 ).

Since the new text (COOL_ST) does not fit within the original shape of
the S3 bubble, click on the bubble, outside its text area. The bubble will
be surrounded with editing lines and little squares. As you drag these lit-
tle editing squares away from the center of the bubble, the bubble be-
comes oval-shaped. Release the mouse button when the oval becomes
sufficiently large for the COOL_ST text. To fit the text in the center of the

Figure 2-22. Entering Machine State Symbols.

Figure 2-21. State Name Before The Bubble Expansion.
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new oval-shaped bubble, click on it and drag it to the desired position in-
side the bubble, as shown below (Figure 2-24).

After completing editing of the machine state ‘bubbles’, you should end-
up with the figure below (Figure 2-23).

Entering Machine State Transitions

Select the Transition toolbar and click in the center of the OFF bubble.
Note that a line follows each cursor movement. position the cursor over
the FAN_ST bubble and click the mouse button. In response, a line is
drawn between both state machine ‘bubbles’. To allow for more complex
line shapes, you can click the mouse button several times as you draw a
segmented line between two bubbles. The figure below shows such seg-
mented line between the OFF and COOL_ST bubbles.

Draw two additional lines, as shown in the figure below (Figure 2-26). To
edit them, switch to the edit mode by activating the Select toolbar.

Figure 2-24. Alignment Of Text Inside State Bubble

Figure 2-23. Machine States After Editing.
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With the Select toolbar active, click on the transition line between the
OFF and FAN_ST bubbles. The line will change to a dotted line and will
have some little squares. To edit the diagram, follow these rules:

r Pull on the little squares to force the transition line into the desired
shape.

r For more flexibility place segmented transition lines
r Click at the tip of the transition line to move it along the bubble outline.
r Click at the bubble to move it to a new position on the schematic screen.
r You can re-edit the diagram at any time.

An example of edited transition lines is shown below (Figure 2-25).

Entering Conditions

To add conditions to transition lines, select the Conditions toolbar. Next,
click on the line and enter the desired text. During editing the text is dis-
played within a box. When you click outside the editing area, the box dis-
appears.

Figure 2-26. Adding Transitions To A Diagram.

Figure 2-25. Edited Transition Lines.
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To complete the design, draw the transition lines shown in the figure be-
low (Figure 2-27).

Entering Actions (Output Pins State)

You can explicitly specify the logical state of output pins for each ma-
chine state. The process of setting the output pins is called ‘actions’. AC-
TIVE-State Editor allows the following state machine ‘actions’:

r Entry Action - output pins are changing upon the entry into a machine
state

r State Action - output pins are changing while a machine state is
executed

r Exit Action - output pins are changing upon the exit from a machine
state

r Transition Action - output pins are changing upon detection of ma-
chine state transition

The ‘action’ type is selected by clicking on the appropriate icons in the
toolbar. The most popular ‘action’ is the Entry Action in which the out-
put pins are changing concurrently with the entry into the selected ma-
chine state. Let’s assume that in our design the output pins are changing
their logical states upon entering a new machine state.

Click on the Entry Action button. A small rectangle will appear and fol-
low the mouse cursor. Click the mouse cursor within the OFF bubble
and start entering the text listed below:

Figure 2-27. Graph With Transitions And Conditions.
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FAN <=’0’; - assigning ‘0’ logical state to the FAN output pin

TIM_S <=’0’; - assigning ‘0’ logical state to the TIM_S output pin

COOL<= ‘0’; - assigns ‘0’ logical state to the COOL output pin

NOTE: VHDL syntax requires you to place the ‘;’ (semi-colon) marker af-
ter the logical state assignment. If you miss this marker, VHDL editor will
give you an error message!

Complete the AIR_COND design as shown in figure below (Figure 2-28).

Compilation Of State Machine Into VHDL Code.

System Signal Setup
State machine designs are driven by common clocks, reset and other sig-
nals, which can be set by selecting the FSM/Machine option (Figure 2-
29). You must set these signals before generating HDL code from the
state machine.

Figure 2-28. AIR_COND Design State Machine.
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r Encoding allows the designer to select the coding scheme (e.g. binary,
one-hot, etc.)

State machine design may have a general reset signal. You need to enter
the input reset signal in the Signal field. You must specify its:

1. Type (Asynchronous or Synchronous)

2. Active Level (High or Low logical level)

In addition, you must specify in the State field the default state after the
reset signal has been applied.

Figure 2-29. A Window For Setting Common Signals.
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To select default and the trap conditions, click on the Defaults option in
the Machine Properties window, selected by the FSM/Machines option.

Figure 2-31. A Window For Setting Reset Conditions.

Figure 2-30. Default And Trap State Setup Window.
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Compilation Setups
After the state machine design has been completed, you need to compile
it into a VHDL. Select the Synthesis/Configuration option. In response,
the HDL Configuration window will be displayed (Figure 2-32). You
need to select from that window:

r Language (ABEL, VHDL or MINC-DSL)
r Logic Synthesis tool for which the VHDL code has to be fine-tuned

(e.g. Exemplar, Synopsys, ASYL+, Metamor, etc.)

Since the output signal assignments for the fastcooling state machine has
been made using the VHDL syntax, you will need to compile it with the
VHDL option.

A fine tuning of the code for the specific logic synthesis tool is required
because these tools may work with different subsets of the VHDL and
ABEL design languages.

Design Compilation
After the common state machine signals have been defined and the tar-
get logic synthesis environment has been set, you need to compile the de-
sign. Select the Synthesis/HDL Code Generator option. ACTIVE-State
Editor will automatically process the state machine design and generate
the selected HDL code.

Should any errors be found during the VHDL code generation, you will
be warned, and a location of the error will be provided.

Figure 2-32. Selecting Language/Logic Synthesis Tool
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Typical VHDL Entry Errors
1. Missing the semi-colon character (;) after the assignment statement, e.g.

FAN<=’1’ is wrong. The correct statement is FAN<=’1’;

2. Missing or misspelled signal names

3. Two or more machine states are forced active concurrently

4. Missing Clock or Reset signals (undefined)

5. Different clocks for different state machines (within the same device)
are used

6. Improper reset signal operation

Sample FSM ABEL Design

ABEL Language Basics
ABEL is one of the oldest HDL languages. Because of its simplicity, its
use is wide-spread. If you plan on converting FSM designs into ABEL,
you need to learn the following specification:

Object Types

r Signals (ports); single-bit items, e.g. CLK, reset, Enable
r Constants; typically 0 and 1, but can also be 78 (temperature), etc.
r Sets; a collection of Signals Q=[q1,q2,q3] or Constants [0,1,1]

Operators

r Logical;
! NOT

& AND

# OR

$ XOR

!$ XNOR

r Arithmetic;
- MINUS

+ PLUS

r Relational;
= = equal

!= not equal

< less than
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<= less than or equal

> greater than

>= greater than or equal

Assignment

r Combinatorial = ; assigns logical states to combinatorial outputs
r Registered := ; the logical state on the right-hand side is forced into

the signal on the left of the equation statement, e.g. Q3 := 1 will force
1 logical state into D input of flip-flop Q3

Expressions

r Logical Expression for conditions, e.g. ON_OFF & TMP3 (ON_OFF
switch is ON AND TMP3 switch is also ON or TRUE), TMP2 & TIM=4
(switch TMP2 is ON and timer TIM equals or exceeded 4 minutes).
These conditions can be assigned to transitions on the FSM graph and
be tested for.

r Assignment Statement for actions, such as assignment of logical states
to output pins, e.g. TIM_S = 0; FAN = [0,0,1,1];

CL_CTRL2

This control system is optimized for energy efficiency:

Figure 2-33. A State Machine Design With ABEL Syntax.
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1. After the ON-OFF push button switch is activated, and temperature is
over 80 degrees F, the first fan is turned on.

2. If the temperature does not fall below 78 F within 2 minutes, a second
fan is turned on.

3. If after additional 2 minutes the temperature does not fall below 78 F, a
third fan is turned on

4. The 4th fan is turned on after additional 2 minutes, if the temperature
remains over 78 F.

5. If after additional 10 minutes the temperature does not fall below 78 F,
a cooling system is turned on.

6. The cooling system and fans are automatically turned off if at any time
the temperature drops below 65 F.

An FSM diagram of this controller is shown above (Figure 2-33).

System Signal Setup

After the bubble diagram has been drawn, you need to define common
signals such as clock, reset and other global signals, which can be set by
selecting the FSM/Machine option (Figure 2-34). You must set these sig-
nals before generating HDL code from the state machine.

You need to set in the above figure as a minimum:

Figure 2-34. A Window For Setting Common Signals.
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1. Clock (Rising or Falling edge)

2. State encoding scheme:

r Symbolic causes the logic synthesis tool to perform the state coding
r Encoding allows the designer to select the coding scheme (e.g. binary,

one-hot, etc.)

State machine design may have a general reset signal. You need to enter
the input reset signal in the Signal field. You must specify its:

1. Type (Asynchronous or Synchronous)

2. Active Level (High or Low logical level)

In addition, you must specify in the State field the default state of the
state machine, after the reset signal has been applied.

Compilation Setups

After the state machine design has been completed, you need to compile
it into ABEL code. Select the Synthesis/Configuration option. In re-
sponse, the HDL Configuration window will be displayed (Figure 2-36).
You need to select from that window:

r Language (ABEL)
r Logic Synthesis tool (e.g. XABEL, ASYL+, Metamor, etc.)

Figure 2-35. A Window For Setting Reset Conditions.
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Since the output signal assignments for the CL_CTRL2 FSM design has
been made using the ABEL syntax, you will need to compile it with the
ABEL option.

Design Compilation

After the common state machine signals have been defined and the tar-
get logic synthesis environment has been set, you need to compile the de-
sign. Select the Synthesis/HDL Code Generator option. ACTIVE-State
Editor will automatically process the state machine design and generate
ABEL code.

Figure 2-36. A Setup Window For ABEL Code Generation.
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Design Examples

1. Try to analyze the operation of the above design.

2. Convert the design to a 3-bit counter.

3. Convert the design to a 6-bit counter.

4. Force the design to start after RST_IN in the INCREMENT state.

5. Change the design clock from rising to falling edge.

6. Convert the design from ABEL to VHDL format

Tests And Responses:

1. Try to analyze the operation of the above design:

This is a design of a counter which counts continuously from 0 to F/h
(hexadecimal). Upon reaching F/h, it overflows and starts counting from
0 again.

The START =1 starts the COUNTER which counts up continuously till
the START=0. At that instant the COUNT permanently holds the last nu-
merical value and the STOP(=1) signal is being generated. The machine
goes to the HOLD1 state for one clock cycle, and then is forced into the
HOLD2 state in which it awaits a new START signal.

Figure 2-37. ABEL FSM Diagram: Number Generator
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Upon receiving a new START signal, the machine goes into the ZERO
state and sets the COUNTER to [1,1,1,1]. In the next clock, if START stays
at logical 1, the machine goes into the INCREMENT state and starts in-
crementing the COUNTER.

2. Convert the design to a 3-bit counter:

Change the name of the COUNT[0:3] port to COUNT[0:2] port in the
above figure. To change the port name, click on the COUNT[0:3] port
name, located at the top of the screen in the I/O PORT section, and edit it
directly on the screen to COUNT[0:2]. You can also position the mouse
cursor over the COUNT[0:3] port’s graphical outline and click the right
mouse button. In response, ACTIVE State Editor will display the figure
below (Figure 2-38).

Select the Properties option, and when the Port Properties window ap-
pears, edit the COUNT [0:3] to COUNT[0:2] directly in this window. Use
the Range field to set the bus range, e.g. 0:3.

NOTE: If you click the right mouse button over the port’s name instead
of the port’s outline, a different set of windows will be displayed. They
will allow you to edit the signal name properties instead of the port prop-
erties.

Figure 2-38. Selecting The Port Properties Option.
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Change the ‘action’ in the ZERO state from COUNT=[1,1,1,1] to
COUNT=[1,1,1]. You can edit it directly on the FSM diagram. As an alter-
native, you can place the mouse cursor over the COUNT editing area
and press the right mouse button. A displays in figure below will appear
(Figure 2-40).

Select the Properties option from the above figure and when the Action
Properties window appears (Figure 2-41), select the Edit option (Figure 2-
42).

Figure 2-39. Port Properties Window.

Figure 2-40. Menu for Editing Flowchart Parameters.

Figure 2-41. Action Properties Window.
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You can edit the COUNT from [1,1,1,1] to [1,1,1] directly in the above
window.

3. Convert the design to a 6-bit counter:

r Starting with the state machine diagram, change the COUNT[0:3] port
to COUNT[0:5] port directly on the diagram. If you are modifying
design in the Example 2, above, change from COUNT[0:2] port to
COUNT[0:5] port.

r Change the ‘action’ in the ZERO state from COUNT=[1,1,1,1] to
COUNT=[1,1,1,1,1,1]. If you are starting from Example 2, above,
change the ‘action’ from COUNT[1,1,1] to COUNT[1,1,1,1,1,1]

4. Force the design to start after RST_IN in the INCREMENT state:

A. Manually;

Drag the tip of the RST_IN signal line from the ZERO state to the INCRE-
MENT state. Click on the associated small squares to change the shape of
the RST_IN signal line .

B. Automatically;

Position the mouse cursor over the RST_IN signal line and click the right
mouse button. A new menu appears. Select from that menu, which is
shown below, the Properties option.

Figure 2-42. Editing Of State Properties.
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ACTIVE State Editor responds with Transition Properties window. Se-
lect the Increment option from the To field. This automatically redraws
the RST_IN signal line and places it in direct contact with the INCRE-
MENT state bubble. If you want to change the shape of the RST_IN sig-
nal line, click on it and drag it to the desired shape.

NOTE: If you click the right mouse button over the line’s name instead of
the line itself, a different set of windows will be displayed. They will allow
you to edit the signal name properties instead of the line properties.

If the RST_IN signal line feeds directly into the INCREMENT state, it
will start counting up from an unknown state because no reset through
the ZERO state will be made. You must return the RST_IN signal line
back to the ZERO state to have a predictable operation by always start-
ing from the COUNT:=[1,1,1,1,1,1] state.

Figure 2-43. Selecting The Properties Of Signals.

Figure 2-44. The Transition Properties Options.
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NOTE: If there are more than one (1) transition line coming out of any
state bubble, it is best to assign to it a priority in the Priority field (Figure
44). This will automatically resolve a conflict that may arise when two
transition conditions are concurrently fulfilled.

5. Change the design clock from rising to falling edge:

Select the state machine name (e.g. fastcooling) from the FSM/Machines
option

ACTIVE-State Editor displays the menu below for setting up the active
clock edge.

Figure 2-45. Selecting FSM Design For Editing.

Figure 2-46. Changing the Clock Setup.
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6. Convert the design from ABEL to VHDL format

r Select the Configuration option from the Synthesis menu. In re-
sponse, ACTIVE Synthesis Editor displays the figure below. Select
from the VHDL option in the Language field and the desired logic
synthesis tool (e.g. ASYL+) from the Tools field.

r Change the ABEL operators to VHDL operators (from := to <=). You
can do it through manual editing right on the graph. Another option
is to select the Search option from the main menu. When the Search
menu appears, select the Find and Replace option.

When ACTIVE State Editor displays the Replace window, enter the item
to be replaced, as shown below.

Figure 2-47. VHDL Selection Options.

Figure 2-48. The Search Menu Options.
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The Replace window allows global replacement of all ABEL expressions
to VHDL expressions. You need to visually verify if all ABEL expressions
have been changed to the VHDL format.

r Change all listed below ABEL expressions to VHDL:

Conditions:

!START to START=’0’

RST_IN to RST_IN=’1’

START to START=’1’

Actions:

all 0’s into ‘0’

all 1’s into ‘1’

States:

Change the Increment state from 1 to “0001” (in VHDL you cannot mix in-
tegers and bit_vectors)

Change the ZERO state from [1,1,1,1] to “1111”

Select the Port Properties window (Figure 39), and redefine the COUNT
port as bi-directional (all bus ports must be bi-directional).

Figure 2-49. ABEL->VHDL Global Expression Replacement.
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You need to set in the above figure as a minimum:

1. Clock (Rising or Falling edge)

2. State encoding scheme:

r Symbolic causes the logic synthesis tool to perform the state coding

NOTE: You must add a semicolon (;) at the end of each VHDL expres-
sion. The omission of the ‘;’ character is the most popular source of com-
pilation errors.

Design Examples 2-43


	ACTIVE-State Editor User’s Guide
	ACTIVE-CAD System Components
	Preface
	Introduction
	ACTIVE-CAD - State Editor Features Overview
	Installation
	Requirements
	Additional Requirements
	WINDOWS Environment
	System Start-Up

	ACTIVE-State Editor Window
	Main Menu Options

	Detailed Menu Description
	The File Menu Options
	File | New [CTRL+N]
	File | Open [CTRL+O].
	File | Save.
	File | Save As.
	File | Print [CTRL+P].
	File | Print Preview.
	File | Print Setup.
	File | Page Setup.
	File | Files List.
	File | Exit.

	The EDIT Menu Options
	Edit | Undo [CTRL+Z].
	Edit | Redo [CTRL+A].
	Edit | Cut [CTRL+X].
	Edit | Copy [CTRL+C].
	Edit | Paste [CTRL+V].
	Edit | Delete [DEL].
	Edit | Select All.
	Edit | Symbol.
	Edit | Settings.
	Edit | Settings | Text.
	Edit | Settings | Line.
	Edit | Settings | Fill.

	The SEARCH Menu Options
	Search | Find String [Alt+F3].
	Search | Find Next [F3].
	Search | Find and Replace.
	Search | Previous error [Shift+F4].
	Search | Next error [F4].

	The View Menu Options
	View | Zoom in [CTRL+].
	View | Zoom out [CTRL -].
	View | Zoom Select.
	View | Page [PgDn].
	View | Previous [PgUp].
	View | Toolbars.
	View | Status bar.
	View | Machine Frames.
	View | Grid.
	View | Redraw [F10].

	The Toolbars
	The Main Toolbar.
	The FSM Toolbar.
	The Draw Toolbar

	The FSM Menu Options
	FSM | Machines.
	FSM | Select.
	FSM | State.
	FSM | Transition.
	FSM | Condition.
	FSM | Action.
	FSM | Declarations.
	FSM | Input Port.
	FSM | Output Port.

	The Draw Menu Options
	Draw | Text
	Draw | Bezier Curve
	Draw | Circle
	Draw | Rectangle

	The SYNTHESIS Menu Options
	Synthesis | Configuration.
	Synthesis | HDL Code Generation [CTRL+H].
	Synthesis | Options
	Synthesis | Synthesize.
	Synthesis | View Report.

	The PROJECT Menu Options
	Project | Add toProject
	Project | Create Macro
	Project | Update Macro

	The TOOLS Menu Options
	Tools | Preferences.
	Tools | Project Manager.
	Tools | HDL Editor.
	Tools | Simulation.

	The Help Menu Options
	Help | Help Index
	Help | Using Help
	Help | About State Editor


	Context Sensitive Menu
	States, Transitions, Conditions, & Actions
	Transition Text & Transition Properties
	Condition Text & Condition Properties
	The ‘DRAW’ Toolbar Context Sensitive Menu
	The FSM Diagram Context Sensitive Menu.

	Basic Elements of the Windows ‘95 interface
	GLOSSARY
	Basic Vocabulary & Commonly Used Abbreviations
	Main Menu Command Index

	ACTIVE-State Editor Applications Guide
	Introduction
	Basic Vocabulary
	What Do You Need To Know About VHDL?

	Drawing State Machines With The FSM Wizard
	FSM Design Wizard
	Entering An FSM Diagram Under The Wizard

	System-Level FSM Design Process
	AIR_COND System-Level Design
	Create Top-Level Schematic Sheet
	Edit Block Symbol In Symbol Editor
	Place The New Symbol On The Schematic Sheet
	Selecting HDL Language
	Entering Input Signals
	Entering Clock Signals
	Entering Output and Bi-directional Ports
	Entering Bus names
	Editing I/O Ports

	Entering The State Machine Designs
	Compilation Of State Machine Into VHDL Code.
	System Signal Setup
	Compilation Setups
	Design Compilation
	Typical VHDL Entry Errors

	Sample FSM ABEL Design
	ABEL Language Basics

	Design Examples


